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About Kid Pix Deluxe 3
In this chapter, you’ll learn about:

• Getting Started with Kid Pix Deluxe 3

• Introducing the Paint Zone

• Introducing the SlideShow

• Getting Help

Welcome to Kid Pix Deluxe 3! Since its first release 
in 1991, Kid Pix has won over 45 awards and is the 
number-one bestselling art software for children. 
Kid Pix has inspired children to express their natu-
ral creativity with innovative, fun, and wacky art 
tools.

Kid Pix Deluxe 3 has two parts: 

• The Paint Zone lets you create pictures with 
drawing and painting tools.

• SlideShow lets you put pictures into a pre-
sentation with visual transitions and sounds. 
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Getting Started on Windows
Once you’ve installed Kid Pix Deluxe 3 on a com-
puter using Windows 95, 98, 2000, NT, or Millen-
nium Edition, here’s how to start.

To start Kid Pix Deluxe 3:

1.   Put the Kid Pix Deluxe 3 CD in the CD-ROM 
drive.

2.   Do one of the following:

•    If you see the startup window, click Start 
Kid Pix.

•    If you don’t see the start-up window, 
double-click the Kid Pix Deluxe 3 
desktop shortcut, or choose Kid Pix 
Deluxe 3 from the Start menu.

3.   If this is your first time using Kid Pix Deluxe 
3, type your name in the box that says 
Enter your name here.

From now on, your name will be in the list 
and you can click it or type it again to start.

4.   Click Go to start Kid Pix.
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Getting Started on Macintosh
Once you’ve installed Kid Pix Deluxe 3 on a Macin-
tosh computer, here’s how to start.

To start Kid Pix Deluxe 3:

1.   Put the Kid Pix Deluxe 3 CD in the CD-ROM 
drive.

2.   Do one of the following:

•    Double-click the Kid Pix Deluxe 3 
desktop shortcut.

•    Double-click the Kid Pix Deluxe 3 folder, 
then double-click the Kid Pix Deluxe 3 
icon.

3.   If this is your first time using Kid Pix Deluxe 
3, type your name in the box that says 
Enter your name here.

From now on, your name will be in the list 
and you can click it or type it again to start.

4.   Click Go to start Kid Pix.
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The Kid Pix Paint Zone
When you start Kid Pix Deluxe 3, you see the Paint 
Zone:
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Print
Help
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The Kid Pix SlideShow
You can make a SlideShow with your pictures. Read 
“Using SlideShow” on page 72 to learn more about 
this great feature 
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Using the Menus
Kid Pix Deluxe 3 has menus you can display and 
use. For a full list of all the menu options, see “The 
Kid Pix Deluxe 3 Menus” on page 91.

To display the menus:

1.   Move your mouse to the very top of the 
screen.

2.   When you see a triangle outlined in white, 
press the mouse button and hold it down.

3.   Drag the mouse to a menu to display it, and 
then drag down to the command you want.

Getting Help
In the Paint Zone or the SlideShow, you can find 
out about anything on the screen. A Help window 
appears and a voice reads the information.

You can view or print the guide you’re reading now 
(the Kid Pix Deluxe 3 User Guide). For late-breaking 
news, check the Read Me file.
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To get on-the-spot help:

1.   Click the question mark.

2.   Click the item you want help with.

3.   Read and listen to the help message.

4.   To hear the message again, click Replay. 

5.   To close the help window, click OK.

To view or print the User Guide:

1.   From the Help menu, choose View User 
Guide.

2.   In Acrobat Reader, read or print information.

To view the Read Me file:

• If you’re using Windows, click the Start but-
ton on your desktop and choose Readme 
from the Kid Pix Deluxe 3 program group.

• If you’re using Macintosh, double-click the 
Read Me file in the Kid Pix Deluxe 3 folder.
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Using the Art Tools
In this chapter, you’ll learn about:

• Using Drawing Tools

• Using Painting Tools

• Using Fill Buckets

• Using Mixers

• Using Rubber Stamps

• Using Paper Texture

• Using the Color Picker and Eye Dropper

• Using Erasers

• Using the Undo Guy
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Using Drawing Tools
Use Kid Pix Drawing Tools to draw different kinds of 
lines. There are four drawing tools: Pencil, Chalk, 
Crayon, and Marker. You can draw freehand, 
straight, or curved lines, rectangles, ovals, or poly-
gons.

To draw:

1.   Click the Drawing Tools button.

2.   Pick a tool from the left side of the tray.

3.   Choose a size for your line.

4.   Choose a shape.

Pencil

Chalk

Crayon

Marker

Sizes
(solid) (hard/fuzzy)

(soft/fuzzy) (see-through)

Shapes
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5.   Click in the drawing area and hold down the 
mouse button. Move the mouse around to 
draw. 

For rectangles, ovals, and polygons, you can 
draw either a filled or an empty shape. 
Empty shapes let the background show 
through.

•    To draw a curve, click the Curve shape 
and hold down the mouse button while 
you draw a line. Release the mouse 
button, then bend the line to the curve 
you want.

•    To draw a polygon, click the Polygon 
shape. Draw the sides, clicking after each 
one. Finish by clicking the starting point.

Filled 
shapes

Empty
shapes

Freehand StraightCurve

Rectangle Oval Polygon

Line
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Drawing Tips

• If you change the Paper Texture and then 
draw with the Crayon, Chalk, or Marker, a 
pattern shows through under your drawing. 
For more on Paper Texture, see “Using Paper 
Texture” on page 24.

Using Painting Tools
Use Kid Pix Painting Tools for a dazzling array of 
realistic and out-of-this-world painting effects. 
Choose from Paintbrushes, Sound Art, and Spray 
Cans. Each tool has two modes.

To paint:

1.   Click the Painting Tools button. 

2.   Click the Paintbrush, Sound Art, or Spray 
Can tool.

Look on the next few pages for more 
information about each kind of tool.

3.   Choose a size (not all tools have sizes).
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4.   Choose a painting mode.

When you pick a mode, the options change.

5.   Choose a painting option.

6.   Click in the drawing area and hold down the 
mouse button. Move the mouse around to 
paint.

Paintbrushes
Click the Paintbrush and choose a brush size and 
painting mode. Realistic mode paints like a real 
brush.  

Wacky mode creates magical effects.

Paintbrush Sizes Realistic Paint Options
Paint Mode

Wacky 
Paint Mode Paint Options
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Sound Art
To use Sound Art, talk, sing, or play music into a 
microphone attached to your computer. Mouse-
move lets you direct the painting with your mouse.

Hands-free lets the sound do the painting.

Sound Art Size Mouse-move

Sound Art Hands-free
USING THE ART TOOLS 13



K I D  P I X  D E L U X E  3
Spray Cans
3D Shapes mode sprays three-dimensional bal-
loons, candy, shapes, or bugs.

Moving Paint mode sprays balloons, bubbles, and 
creatures that dance, fly, hop, or wiggle.

Painting Tips

• Experiment with the Painting Tools, modes, 
and options. Try lots of different combina-
tions.

• For information on adding text in Wacky Paint 
Mode, see “ABC Text Tool” on page 32.

Spray Can Size 3D Shapes Mode

Moving Paint Mode
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• Some of the realistic Paintbrushes let the 
Paper Texture show through. For more about 
Paper Texture, see “Using Paper Texture” on 
page 24.

Using Fill Buckets
Fill buckets let you fill up an area of your picture. 
There are three Fill Buckets. Solid fills an area with 
one solid color or a single-color pattern. Blend fills 
an area with a blend of colors. Pattern fills an area 
with a multi-color pattern. 

To fill an area:

1.   Click the Fill Bucket button to see the Fill 
Buckets tray. The tray looks different, 
depending on the tool and mode you pick.

Solid
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The Solid Fill Bucket uses the current color 
in the Color Picker. Choose solid or a single-
color pattern.

The Blend Fill Bucket doesn’t use the 
current color in the Color Picker. 

The Pattern Fill Bucket doesn’t use the 
current color in the Color Picker. You can 
pick a multi-colored pattern.

2.   Pick a bucket from the left side of the tray.

3.   Choose a fill from the right side of the tray.

4.   Click inside the area to fill.

Blend

Pattern
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Fill Tips

• If you fill with a blend, you can hold the 
mouse button down on your picture while the 
blend appears. Then, without releasing the 
mouse button, move the mouse around to 
change where the blend colors appear inside 
the filled area on your picture.

• You can design your own two-color patterns. 
Fill an area with a solid color, then change 
the current color and fill the same area with a 
single-color pattern.

• For information on changing the color for 
solid fills, see “Using The Color Picker and 
Eye Dropper” on page 25.
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Using Electric Mixers
Electric mixers mix up your picture. You can mix up 
the whole painting with a mega-mixer, or just parts 
of the painting with a mini-mixer.

To mix things up:

1.   Click the Mixer button to see the Mixers 
tray.

2.   Pick the mega-mixer or the mini-mixer from 
the left side of the tray.

The mega-mixer mixes up the whole picture 
with one click; the mini-mixer mixes where 
you drag the mouse.

3.   For the mini-mixer, choose the mixer size.

4.   Choose a mixing option from the right side 
of the tray.

Sizes OptionsMega Mini
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5.   Click your picture with the mega-mixer or 
drag the mouse with the mini-mixer to mix 
areas on your picture.

Mixer Tips

• Mix up an imported photograph for fun 
results. For information on importing photos, 
see “Adding Pictures from Other Programs” 
on page 56.

• You can change the size for some mini-mix-
ers. Use different sizes for different effects.
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Using Rubber Stamps
Use the Rubber Stamp tool to stamp animals and 
other shapes onto your picture.

To use Rubber Stamps:

1.   Click the Rubber Stamp button to see the 
Rubber Stamps tray.

2.   Choose a folder.

3.   Scroll through the stamp choices.

4.   Click the size for your Rubber Stamp.

5.   Click a Rubber Stamp, then click your 
picture.

Folders Size Rubber StampsStamp 
Editor
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Editing Rubber Stamps
You can edit Rubber Stamps and create your own. 

To edit rubber stamps:

1.   Click the Rubber Stamp button to see the 
Rubber Stamps tray.

2.   Click the stamp you want to edit.
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3.   Click the Stamp Editor (pencil) to see the 
Rubber Stamp Editor.

Use these tools to change your stamp:

•    Use the Pencil to draw on the stamp.

•    Pick a color in the Rubber Stamp Color 
Picker and use the Fill Bucket to recolor 
the stamp.

•    Click Undo to reverse your last change, 
or click Restore Original to go back to 
the original stamp.

Pencil Fill Bucket
Firecracker

Rotate

Undo

Flip
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•    Use the Firecracker to erase the whole 
picture so you can start from scratch.

•    Click Flip to turn your stamp over from 
left to right.

•    Click Rotate to turn your stamp 90 
degrees each time you click.

4.   Click OK when you’re finished.
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Using Paper Texture
You can change the background texture of your Kid 
Pix picture. Then, when you draw with the Crayon, 
Marker, or Chalk, a pattern will show through 
under your drawing.

To change the paper texture:

1.   Click the Paper Texture button at the 
bottom right corner of your drawing page.

The Paper Texture tray opens.

2.   Scroll through the paper textures in the 
tray.

3.   Click the texture you want.

You can see the texture you selected next to 
the Paper Texture button. 

4.   Draw with the Crayon, Marker, or Chalk to 
see the texture.
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Using The Color Picker and Eye 
Dropper

Many Kid Pix art tools use the color you choose 
from the Color Picker. You can see the current color 
in the color splotch at the bottom left of the screen 
and on many drawing and painting tools.

The Color Picker also includes the Eye Dropper, a 
tool that lets you pick up any color in your picture 
to use instead of a color in the Color Picker.

To pick a color in the Color Picker:

1.   Move your mouse toward the color splotch.

Color Splotch
Eye Dropper

Regular
Colors

Skin Tones

Grays
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The Color Picker pops up.

2.   Click a color on the Color Picker.

Choose a regular color, a shade of gray, or a 
skin color. As soon as you click a color, the 
color splotch changes to show your new 
choice. Move the mouse off the Color Picker 
to close it and begin painting or drawing.

To pick up a color with the Eye Dropper:

1.   Open the Color Picker by moving your 
mouse near it.

2.   Click the Eye Dropper.

3.   Move the Eye Dropper over your picture.

As your mouse moves, the color splotch 
changes to show the color that the Eye 
Dropper can pick up.

4.   Click when the color you want appears on 
the color splotch.

The Color Picker closes. The color you 
clicked becomes the new color for drawing 
and painting.
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Using Erasers
The Big Eraser erases your whole picture.  Any 
paper texture or sound you added to your picture is 
still there. You can also click the Firecracker to 
erase your whole picture. The Little Eraser erases 
where you drag with the mouse, leaving white 
space.

You can’t erase stickers, animations, movies, or 
text boxes. (To erase these, select them and then 
press the Delete key.) 

To erase your whole picture:

1.   Click the Eraser button.

The Erasers tray appears.

2.   Click the Big Eraser.

3.   Click your picture.

Little 
Eraser

Big
Eraser

Eraser 
Options

Sizes/
Shapes
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To erase part of your picture:

1.   Click the Eraser button.

The Erasers tray appears.

2.   Click the Little Eraser.

3.   Click a size for the eraser.

4.   Pick one of these:

•    To erase with a round outline, click the 
circle setting. 

•    To erase with a square outline, click the 
square setting.

5.   Pick an eraser option.

6.   Drag where you want to erase.

Using The Undo Guy
Click the Undo Guy whenever you do something to 
your picture that you don’t want to keep. Click 
again to redo what you just undid.
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All About Text
In this chapter, you’ll learn about:

• Adding Text

• Working with Text Boxes

• Changing the Way the Letters Look

• Checking Spelling

• Reading Text Out Loud

Adding Text
There are three ways to add text:

• Draw a text box and type the text. 

• In Small Kids Mode, add rubber stamp letters 
to the picture. 

• Use the ABC Text feature to paint wacky text 
onto your picture.
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Drawing Text Boxes
When text is in a text box, you can check its spell-
ing and make your computer read it out loud.

To add text:

1.   Click the Text button.

The Text tray appears.

2.   Click your picture where you want the text.

3.   Start typing.

The text box grows as you fill it up.

Formatting
Options

Editing
Options

Text 
to Speech Voice
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Text in Small Kids Mode
In Small Kids Mode, adding text is like using a rub-
ber stamp. Letters become part of the background. 
You can’t check spelling, change the text appear-
ance, or make your computer read the text out 
loud, but Kid Pix says the letters’ names when you 
click them in the Text tray.

To add text in Small Kids Mode:

1.   Click the Text button.

The Text tray appears.

2.   Click any letter in the tray to hear its name.

To see more letters and numbers, click the 
scrolling arrows on the Text tray.

3.   Click a letter to add it.
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ABC Text Tool
ABC Text becomes part of the background. You 
can’t change it after you add it to your picture.

To use the ABC Text tool:

1.   Click the Toolbox menu.

2.   Click Edit ABC Text.

3.   In the ABC Text dialog box, type the text.

4.   Click OK.

5.   Click the Paint button.

6.   Choose Wacky mode, click the ABC Text 
brush, and start painting to see the text.

Wacky ABC 
Text BrushMode
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Working with Text Boxes
You can resize a text box, move it, or delete it. 
Start by selecting the text box in Grab mode.

To change a text box:

1.   Click the Grab button.

The Grab tray appears.

2.   Click the Hand.

3.   Click the text box to see its edit frame.

4.   Do any of these things:

•    To move a text box, click the box at the 
top of its frame and drag it.
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•    To change the size or shape of a text box, 
drag its handles. The text wraps around 
inside the new shape.

•    To delete a selected text box, press the 
Delete key on your keyboard.

•    To flatten text so it’s part of the 
background, click the Toolbox menu and 
choose Flatten Text.

Text Box Tips

• You can drag text boxes almost all the way 
off the page without deleting them. This lets 
you play text out loud without having text 
boxes appear in the picture.

• If you drag a text box partially off the page, 
it won’t get bigger when you type. A sound 
will tell you when you run out of room to type 
in new letters.
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Changing the Way the Letters Look
You can choose a text size, color, and style for the 
text in any selected text box. In Small Kids Mode, 
try painting the letters. 

To change the look of all text in a text 
box:

1.   Click the Text button to see the Text tray.

2.   Click the text box you want to change.

3.   Do any of these things:

•    To change the font, click the arrows next 
to the Font box.  

•    To make text bigger or smaller, click the 
arrows next to the Font Size box.  

•    To change the style, click the Bold, 
Italic, or Underline buttons. 

•    To line up text to the left, right, or center, 
click an Alignment button. 

•    Use the Color Picker to change the color 
of text.
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Checking Spelling
When Kid Pix checks your spelling, it checks all the 
text boxes on your page. You can’t check spelling 
for rubber-stamp text.

To check your spelling:

1.   Click the Toolbox menu.

2.   Click Check Spelling.

3.   If Kid Pix finds a word it doesn’t know, you 
can do any of these things:

•    To change the word, click a word in the 
Suggestions list or type a word in the 
Change To box and click Change.

•    To continue checking spelling without 
changing the word, click Skip.

•    To add the word to your personal 
dictionary (so Kid Pix will recognize it as 
correct from now on), click Learn.

4.   When you’re finished, click Done.
ALL ABOUT TEXT 36



K I D  P I X  D E L U X E  3
Reading Text Out Loud
You can play the picture to hear all the text boxes, 
top to bottom and left to right. You can’t hear rub-
ber-stamp text, except when you click the letters in 
the Text tray. 

To hear one text box read aloud:

1.   Click the text box you want to hear.

2.   Click the Controls menu and click Turn 
Text-To-Speech On.

If the menu says “Turn Text-To-Speech Off,” 
don’t click it—it’s already on.

3.   Click the Read Text button in the Text tray.

To hear all text boxes read aloud:

1.   Click the Controls menu and click Turn 
Text-To-Speech On.

2.   Click the Play button.
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Changing the Voice
Use the Voice box in the Text tray to change the 
voice that reads the text.

To change the voice that reads the text:

1.   Click the Text button.

The Text tray appears.

2.   Click the Voice box and pick a different one.

3.   Click the Read Text button in the Text tray.
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Teaching Kid Pix to Pronounce
Kid Pix might not know how to say people’s names, 
or other special words.

To change the pronunciation:

1.   From the Toolbox menu, choose Say It 
This Way.

2.   In the Original Word box, type the word 
that Kid Pix is pronouncing incorrectly.

3.   In the Pronounce As box, type the 
phonetic spelling of the word.

For example, the letters “ph” sound like “f,” 
so the phonetic spelling of “Stephan” would 
be “Stefan.”

4.   Click Pronounce to hear the new 
pronunciation.

5.   When the word sounds right, click Enter.
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Moving, Copying, Cutting, and 
Pasting

In this chapter, you’ll learn about:

• The Grab Tool

• The Scissors Tool

The Grab Tool
Use the Grab tool to pick things up and move 
them, or cut, copy, and paste them. 

To move things around:

1.   Click the Grab button.

The Grab tray appears.

2.   Click the Grab tool (the hand).
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3.   Click a sticker, animation, movie, or text box 
in your picture.

4.   Do any of these things:

•    To move the thing you clicked, drag it. 
Click to release it.

•    To cut the thing you clicked, click the 
Trash Can in the Grab tray.

•    To copy the thing you clicked, click the 
Copy button in the Grab tray.

•    To paste something you cut or copied, 
click the Paste Jar in the Grab tray, and 
then click where you want to paste.

•    To get rid of the thing you clicked, press 
the Delete key on your keyboard.

The Scissors Tool
Use the Scissors tool to cut out part of your picture 
and paste it someplace else. 
MOVING, COPYING, CUTTING, AND PASTING 41



K I D  P I X  D E L U X E  3
To cut things out:

1.   Click the Grab button.

The Grab tray appears.

2.   Click the Scissors.

3.   Do any of these things:

•    To cut out an area, click the Free Grab 
tool and drag around the area.

•    To cut out a polygon, click the Polygon 
Grab tool and click each point of the 
polygon (at least 3 points). Click the first 
point again to close the shape. 

•    To cut out a circle or an ellipse, click the 
Circle Grab tool and drag from the top 
left of the circle to the bottom right.

•    To cut out a square or a rectangle, click 
the Square Grab tool and drag from the 
top left of the square to the bottom right.

•    To cut out a cookie cutter shape, click a 
cookie cutter, then click your picture.
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Using Libraries
In this chapter, you’ll learn about:

• Using Library Tools

• Backgrounds

• Stickers

• Animations

• Sounds

Using Library Tools
In Kid Pix libraries, you can look in the trays for 
interesting things to add to your picture. At the top 
left of the screen are four oval buttons. Each one 
opens a Kid Pix library.

A background in your picture is like the scenery in a 
play. It goes behind everything else you draw. See 
“Backgrounds” on page 46.
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A sticker floats above your picture like a balloon at 
a parade. You can make it a different size, flip it, or 
move it to a different place. See “Stickers” on 
page 48.

When you “play” your page, the animations move 
around like cartoons. You can drag them anyplace 
in your picture. See “Animations” on page 50.

Each page can have one sound. Pick from a library 
or record your own. See “Sounds” on page 52.

You can also add movies and pictures from other 
programs to your pictures. For more information, 
see “Adding QuickTime Movies” on page 58 and 
“Adding Pictures from Other Programs” on page 56. 
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Library Trays
When you click a library button, the tray for that 
library pops up at the bottom of the screen:

Each library has folders. For example, choose the 
Color Me folder in the Backgrounds library to see 
coloring-book pictures.

To use a Kid Pix library:

1.   Click the folder name to see a pop-up list of 
folders, or use the scrolling arrows to see 
more folders.

2.   Scroll through the choices on the right side 
of the tray until you find one you want.

3.   Drag your choice onto the drawing area.

Folder OptionsScrolling arrows
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Backgrounds
Lots of things you draw are added to the back-
ground and become part of it. For example, when 
you draw a line or paint a circle, that shape 
becomes part of the background. When you change 
the background, those shapes go away, and the 
new background takes their place. If you don’t like 
the result, click the Undo Guy.

To add a background:

1.   Click the Backgrounds button to open the 
Backgrounds tray.

2.   Choose a folder.

3.   Scroll through the backgrounds.

4.   Drag a background onto your picture.

Importing Backgrounds
You can import a photograph or a picture from a 
different program to use as a background. 
USING LIBRARIES 46



K I D  P I X  D E L U X E  3
To import a background:

1.   Click the Add menu and click Import 
Background.

2.   Click a BMP, GIF, JPEG, or PICT file.

3.   Choose one of these options:

•    Shrink/Stretch to Fit Canvas stretches 
or shrinks the picture to fill the whole 
background. The picture might get 
stretched out of shape.

•    Fill Canvas Without Shrinking/
Scaling stretches or shrinks the picture 
to fill as much of the background as it 
can, without stretching the picture out of 
shape. The edges might be left white.

•    Center at Original Size puts the picture 
down the way it was drawn, without 
stretching or shrinking it.

•    Repeat Many Times puts down lots of 
little versions of your picture, until the 
background is filled.

4.   Click OK to import the picture as your new 
background.
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Stickers
Stickers are pictures you “stick” onto your picture. 
Stickers don’t become part of the background 
unless you flatten them. 

To add a sticker:

1.   Click the Sticker button to open the 
Stickers library.

2.   Choose a folder.

3.   Scroll through the stickers.

4.   Drag a sticker onto your picture.
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To move, change, or delete a sticker:

1.   Click a sticker in your picture to see its frame.

2.   Do any of these things:

•    To move a sticker, click inside it and drag.

•    To resize a sticker, drag a Scale handle.

•    To flip a sticker top to bottom, click its 
lower-left handle.

•    To flip a sticker left to right, click its upper-
right handle.

•    To make a sticker part of the background, 
click it, click the Toolbox menu and choose 
Flatten Stickers and Animations. 
Specify the selected sticker or all stickers.

•    To delete a sticker, click it and press the 
Delete key on your keyboard. 

Flip top
to bottom

Flip left
to right

Scale

Scale
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Animations
Animations come to life when you play them.

To add an animation:

1.   Click the Animation button to open the 
Animations library.

2.   Choose a folder.

3.   Scroll through the animations.

4.   Drag an animation onto your picture.

To move, change, or delete an animation:

1.   Click an animation in your picture to see its 
frame.
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2.   Do any of these things:

•    To move an animation, click inside its 
frame and drag. Click to release it.

•    To resize an animation, drag a Scale 
handle on its frame.

•    To make an animation part of the 
background, click it, click the Toolbox 
menu and choose Flatten Stickers and 
Animations. Specify the selected 
animation or all animations.

•    To delete an animation, click it and press 
the Delete key on your keyboard. 

Playing Animations
You can play animations in a loop or frame-by-
frame.

To play an animation in a loop:

1.   Click the animation.

2.   Click the Play in a Loop handle.
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3.   To stop playing the animation, click Play in 
a Loop again.

To play an animation frame-by-frame:

1.   Click the animation.

2.   Click the Frame-by-Frame handle.

Each click advances the animation one 
frame.

Animation Tips

• When you print your picture, the animation 
frame you see is the one that prints. You can 
play the animation step-by-step and stop at 
a different frame.

Sounds
You can add a sound from the Kid Pix Sounds 
library, import one, or record your own. When you 
record or import a sound, it’s added to the My 
Sounds folder in the Sounds library. 
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To add a sound from the library:

1.   Click the Sound button to see the Sound 
library.

2.   Choose a folder.

3.   Scroll through the sounds.

4.   Click a sound to hear what it sounds like.

The sound keeps playing until you click 
somewhere else on the screen.

5.   Drag the sound you want onto your picture 
to add it.

You can hear the sound when you click the 
Play button.

Folders Sounds
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To remove the sound from your picture:

1.   If you’re playing your picture, click the Stop 
button.

2.   Click the No Sound button in the Sound 
tray.

To import a sound:

1.   Click the Add menu and click Import 
Sound.

2.   Find the sound file to import and click it.

If you use Windows, choose a WAV file. If 
you use Macintosh, choose an AIFF file.

3.   To add this sound to the My Sounds library, 
check the Add to Library check box.

4.   Click Open to add the sound to the picture.

Remove sound from library
Record sound

No Sound
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To record a sound:

1.   Click the Microphone in the Sounds tray.

2.   In the Sound Recording tray, click the red 
button to start recording.

3.   Click the blue button to stop recording.

4.   Click the green arrow to hear your sound.

5.   Click the Save button to save your sound.

Give your sound a name so you can find it 
again in the My Sounds folder.

6.   Click the microphone to go back to the 
Sounds tray.

To delete a sound in the My Sounds folder, click it 
and click the Trash Can in the Sounds tray.

Record Playback

Stop Save

Close tray
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Adding Stuff to Your Picture
In this chapter, you’ll learn about:

• Adding Pictures from Other Programs

• Adding QuickTime Movies

Adding Pictures from Other 
Programs

Photographs and pictures you create with other 
programs can become part of your Kid Pix picture. 
You can paint on them or add special effects. 

To add a picture:

1.   Click the Add menu and click Add Graphic.

2.   Find the picture to add and click it.

Choose a BMP, GIF, JPEG, or PICT file.

3.   Choose one of these options:

•     Shrink/Stretch to Fit Canvas 
stretches or shrinks the picture to fill the 
ADDING STUFF TO YOUR PICTURE 56



K I D  P I X  D E L U X E  3
whole background. The picture might get 
stretched out of shape.

•    Fill Canvas Without Shrinking/
Scaling stretches or shrinks the picture 
to fill as much of the background as it 
can, without stretching the picture out of 
shape. The edges might be left white.

•    Center at Original Size puts the picture 
down as is, without stretching or 
shrinking it.

•    Repeat Many Times puts down lots of 
little versions of your picture, until the 
background is filled.

4.   Click Open to add the picture.

5.   Use the handles on the picture to change its 
size, then click inside the picture and drag it 
where you want it.

Picture Tips

• To use a picture as a background, see 
“Importing Backgrounds” on page 46.
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Adding QuickTime Movies
You can add one QuickTime movie to each picture.

To add a movie:

1.   Click the Add menu and click Add Movie.

2.   Find the movie to add and click it.

Make sure you choose a QuickTime file.

3.   Check the Preview.

The preview shows the “poster” for this 
movie, or its first frame.

4.   Click Open to add the movie.

The new movie replaces any existing movie. 

5.   Drag the movie where you want it.

To move or delete a movie:

• To move the movie, click it and drag.

• To delete the movie, click it and press the 
Delete key on your keyboard. 
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Playing Movies
Play movies in a loop or frame-by-frame. Movies 
also play when you play your page.

To play a movie in a loop:

1.   Click the movie.

2.   Click the Play in a Loop handle.

3.   To stop playing the movie, click Play in a 
Loop again.

To play a movie frame-by-frame:

1.   Click the movie.

2.   Click the Frame-by-Frame handle.

Each click advances the movie by one 
frame.

Movie Tips

• If you don’t have your own movies, you can 
use the ones in the QTMovies folder on the 
Kid Pix Deluxe 3 CD. 
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• To make Kid Pix pictures or SlideShows into 
QuickTime movies, see “Exporting Your 
SlideShow” on page 89.

• When you print your picture, the movie 
frame you see is the one that prints. You can 
play the movie frame-by-frame and stop at a 
different frame.

• You can use the handles on the movie to 
resize it.
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Playing, Printing, and Emailing
In this chapter, you’ll learn about:

• Playing Your Picture

• Printing Your Picture

• Emailing Your Picture

Playing Your Picture
When you play your picture, each object on the 
page plays over and over. 

To play your picture:

1.   Click the Play button.

The button changes to a Stop button.

2.   Click the Stop button to stop playing.
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Printing Your Picture
You can print a Kid Pix picture at regular size or as 
a poster. 

Kid Pix prints the frames of movies and animations 
that are showing at the moment that you print. 

Small Kids Mode Users: Kid Pix doesn’t print in 
Small Kids Mode. Turn Small Kids Mode off to print.

To print your picture:

1.   Click the Print button.

2.   Choose Full Page or Poster.

When you print as a poster, Kid Pix prints a 
piece of your picture on each sheet of paper, 
and then you tape the sheets of paper 
together to make the poster.

3.   If you chose Poster, pick 2X2 or 3X3.

The 2X2 choice prints your picture on four 
pieces of paper. The 3X3 choice prints your 
picture on nine pieces of paper.

4.   Click OK to print the picture.
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Emailing Your Picture
When you email a picture from within Kid Pix 
Deluxe 3 , you post the picture to a web site. Kid 
Pix notifies your recipient with a message contain-
ing a link to the site.  

You can send a simple picture (with no sound or 
animations) or you can send your picture in the 
form of a movie (with sound and animations). You 
can’t email SlideShows.

To send or receive Kid Pix email, you need an Inter-
net service provider and a version 4 or higher 
browser (for AOL users, version 5 or higher). To 
send or receive movies, you need Macromedia 
Flash™ Player, version 4 or higher.

When you send email, Kid Pix connects to a web 
site using your Internet browser. You load the pic-
ture onto the site, type a personal message, and 
provide your email address and the email address 
for your recipient. The web site has no advertising 
or links to other sites. When you’re finished, your 
browser closes and you return to Kid Pix. 
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To set up email in Kid Pix:

1.   From the Email menu, choose Set up.

2.   Read the information on the screen.

3.   To allow your child to email pictures from 
within Kid Pix Deluxe 3, click Enable Kid 
Pix Email and click OK.
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To email your Kid Pix picture:

1.   Make sure your computer is connected to 
the Internet.

If you use a dial-up connection, use your 
usual method to dial up to your Internet 
Service Provider.

2.   From the Email menu, choose Send.

3.   Choose Send a Picture or Send a Movie.

•    Send a Picture If your picture has an 
attached sound, or includes movies or 
animations, the person receiving your 
email won’t hear the sound or see the 
movement.

•    Send a Movie Any animations or sounds 
will be included in your email, but it will 
take longer to send.

4.   Click Send.

Kid Pix starts your browser and connects 
you to the Kid Pix Email Center.

5.   Click the button that adds your Kid Pix 
picture or movie to the Send Email page.
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Kid Pix adds your picture or movie to the 
email page. Wait until it’s finished loading.

6.   In the spaces provided, type the email 
address you’re sending your picture to, your 
own email address, and a personal 
message.

7.   Click Preview to see how the message will 
look, and then click Send to send it.

If you want to change your message, click 
Make Changes to This Email.

8.   Click Back to Kid Pix Deluxe 3 when 
you’re finished.

You’ll receive an email message confirming that 
your picture was sent. 
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Working With Pictures
In this chapter, you’ll learn about:

• Starting a New Picture

• Saving a Picture

• Opening a Picture

• Exporting a Picture

Starting a New Picture
You can start with a blank page, or use the Idea 
Machine like an electronic coloring book. 

To start with a blank page:

1.   Click the New button.

If you didn’t save the picture that’s already 
open, Kid Pix asks if you want to save it. 

2.   Click Yes.

The Save dialog box appears.
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3.   Type a name for your picture and click Save 
to save your picture and start a new one.

To use the Idea Machine:

1.   From the Toolbox menu, choose Idea 
Machine.

2.   Click the picture starter you want to use.

3.   Click Open.

If you didn’t save the picture that’s already 
open, Kid Pix asks if you want to save it. 

4.   Click Yes.

The Save dialog box appears.

5.   Type a name for your picture and click Save 
to save your picture and start a new one.

The picture’s sound plays when you open it. 

Saving a Picture
Kid Pix saves your pictures in the My Pictures 
folder, so they’re easy to find and open again. 
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To save your picture:

1.   Click the Save button.

2.   Type a name for your picture.

Kid Pix always asks if you’re sure you want 
to save over an already-saved picture.

3.   Click Save.

Opening a Picture
You can open any picture you created and saved.

To open a picture you saved earlier:

1.   Click the File menu.

2.   Click Open.

If you didn’t save the picture that’s already 
open, Kid Pix asks if you want to save it. 

3.   Click Yes.

The Save dialog box appears.

4.   Type a name for the picture and click Save.

5.   Click the picture to open and click Open.
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Exporting a Picture
You can export a copy of your Kid Pix picture, so 
someone without Kid Pix can play it, or so you can 
open it in a different program. For example, if you 
save your Kid Pix picture in the JPEG format, you 
can add it to a Web page. None of the export for-
mats support Text to Speech. Some of them don’t 
support animation, movies, or sounds.

To export a picture:

1.   Click the File menu.

2.   Click Export.

3.   Navigate to where you want to save your 
exported picture.

4.   Type a name for the exported picture.

5.   Choose an export format.

• JPEG, PICT, or BMP Everything in the 
picture is flattened. If you plan to attach 
the picture to an email message, use the 
JPEG option. JPEG and PICT pictures can 
be opened on a Macintosh computer; 
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JPEG and BMP pictures can be opened on 
a Windows computer. 

• Flash Your animations and sounds will 
play. Flash requires a browser with a 
Flash player plug-in. To download the 
plug-in, point your browser to 
www.macromedia.com.

•    Stand-alone The exported picture runs 
without any other software. If your 
picture has a movie in it, the QuickTime 
file flattens the movie to a single frame. 

• Page As QuickTime Movie The 
exported file can be played on any kind of 
computer, but the person playing it needs 
a QuickTime plug-in or player. To down-
load the plug-in, point your browser to 
www.apple.com. Use the QuickTime 
plug-in to open and play the exported file.

6.   Click Save.
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Using SlideShow
In this chapter, you’ll learn about:

• Creating and Opening SlideShows

• Loading Pictures

• Moving Pictures Around

• Customizing Your SlideShow

• Playing Your SlideShow

• Printing Your SlideShow

• Saving Your SlideShow

• Exporting Your SlideShow

Creating and Opening SlideShows
You can make a SlideShow with your pictures. Load 
pictures into your SlideShow and put them in order. 
Add transition and slide advance options. Then 
save, play, print, or export your SlideShow. 
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Going to SlideShow
You can go back and forth between the Paint Zone 
and SlideShow.

To go to SlideShow:

• Click the SlideShow button in the Paint Zone 
or choose Go to SlideShow from the 
Controls menu.

Starting a SlideShow
You can create a brand new SlideShow or open an 
existing one.

To create a new SlideShow:

1.   Click the New SlideShow button in the 
SlideShow tray at the bottom of the screen.

2.   Type a name for your SlideShow.

The name of your SlideShow appears at the 
top of the screen and a new SlideShow icon 
appears in the SlideShow tray.
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To open a SlideShow:

• Double-click the icon for the SlideShow you 
want in the SlideShow tray at the bottom of 
the screen.

The SlideShow tray shows SlideShows in your My 
SlideShows folder. To open a SlideShow in a differ-
ent folder, use Open on the File menu.

Loading Pictures
Each slideholder in the SlideShow can contain a Kid 
Pix picture. 

Once you load the pictures, you can move them 
into any order you like. If you leave spaces blank, 
the SlideShow will skip those spaces when you play 
your SlideShow.
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To load a picture:

1.   Click the Load button for the slideholder 
where you want the picture to appear.

Hold the mouse over a slideholder to see the 
Load button below it.

2.   Click the picture to load.

3.   Click Open.

Editing Pictures
To change a picture you loaded or create a new pic-
ture, go back to the Paint Zone.

To go back to the Paint Zone:

• Click the Paint Zone button in SlideShow or 
choose Go To Paint Zone from the 
Controls menu.
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Moving Pictures Around
SlideShow plays pictures in the order they appear. 
(The slideholders are numbered so you can tell the 
order.) Drag or move pictures into the order you 
want.

To move a picture by dragging:

1.   Click the picture to move.

2.   Drag it to the new location.

If you drop a picture on a filled slideholder, 
the old picture moves over to make room 
for the new one.

To move a picture by pasting:

1.   Click the picture to move.

2.   Click the Edit menu and click Copy or Cut.

Copy keeps the picture where it is and 
pastes a copy somewhere else.
Cut removes the picture and pastes it 
somewhere else.
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3.   Click the new slideholder for the picture.

4.   Click the Edit menu and choose Paste.

If you drop a picture on a filled slideholder, 
the new one replaces the one that’s there.

To delete a picture from your SlideShow:

1.   Click the picture to delete.

2.   Drag it to the Trash Can or press the 
Delete key on your keyboard.

Seeing All the Pictures
Use the arrows at the top and bottom of the picture 
slideholders to scroll your SlideShow.

Getting Rid of Blanks
You can “clean up” your SlideShow so the blank 
slides don’t interrupt the ones with pictures.

To get rid of blanks:

• Click the Controls menu and click Clean Up.
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Customizing Your SlideShow
You can set slide advance options, visual transition 
effects, and sound effects. 

Slide Advance Options
Slide advance options tell SlideShow when to move 
from one slide to the next. You can have a different 
slide advance option for each slide. You can tell 
SlideShow to move to the next slide after a certain 
number of seconds, or to wait until the text on the 
slide is read aloud, or until you click the mouse or 
press a key on the keyboard.

If you don’t set any slide advance options, each 
slide will show for 7 seconds.

To set slide advance options:

1.   Click the My SlideShow button.
USING SLIDESHOW 78



K I D  P I X  D E L U X E  3
The customizing options appear.

2.   Click the Advance Settings button for the 
slide you want to change. 

Transition
Effects

Advance
Settings

Audio
Options
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3.   Do one of these things:

•    Choose Timer and type the number of 
seconds to wait between this slide and 
the next one. If you want to export your 
SlideShow later, choose this option. See 
“Exporting Your SlideShow” on page 89. 

•    Choose Mouse Click to tell SlideShow to 
wait until you click the mouse before the 
next slide displays.

•    Choose Key Down to tell SlideShow to 
wait until you press any key on your 
keyboard (except Escape) before the 
next slide displays.

•    Choose Read Text Done to tell 
SlideShow to read any text on the slide 
and then display the next slide.

4.   Click OK.

Transition Effects
You can set up special effects between slides, 
including Cut, Wipe, Dissolve, and Iris. Each effect 
has a sound associated with it. You can change the 
sound for any effect.
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To set transition effects:

1.   Click the My SlideShow button.

The customizing options appear.

2.   Click the red Transition Effects arrow in 
front of a slide to change the transition into 
that slide, or click the arrow after the slide 
to change the transition out of that slide and 
into the next one. 

Transition
effects

Advance
settings

Audio
options
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3.   Choose a visual transition effect.

The bottom list scrolls to show you the 
sound for that visual effect.

4.   Leave the sound as it is, click a different 
sound, or click No Sound to make the 
transition silent.

No Sound is at the end of the list.

5.   Click Preview to see how the transition will 
look and sound.

6.   Click OK.

No
Sound
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Audio Options
Audio options tell SlideShow which sound to play 
for each slide. 

To set audio options:

1.   Make sure that Text to Speech and Play 
Attached Sounds are on in the Controls 
menu.

2.   Click the My SlideShow button.

The customizing options appear.

3.   Click the Audio Options button for the slide 
you want to change. 

Transition
effects

Advance
settings

Audio
options
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4.   Tell SlideShow what to do while this slide 
plays:

•    Choose Play Sound to tell SlideShow to 
play the sound attached to this picture. 

•    Choose Play Text to tell SlideShow to 
read the text on this picture out loud. 

•    Turn both options off to tell SlideShow to 
be silent.

5.   Click OK.

Background Color
Slides in a SlideShow appear against a solid color 
background. You can pick the color.

To choose the background color:

1.   Click the Toolbox menu and click Pick 
Background Color.

2.   Pick a color and click OK.
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Playing Your SlideShow
 You can play a SlideShow to see all your effects.

To play your SlideShow:

1.   Click the Play button.

2.   If your slide advance options are set to wait 
for a mouse click or a keyboard key, click or 
type a key to advance the slides.

3.   To stop playing before the SlideShow ends, 
press the Escape key.

Switching to Manual Advance
Switching to Manual Advance keeps your other 
transition and sound settings in place, but lets you 
advance the slides manually.

To switch to Manual Advance:

1.   Click the Controls menu and click Turn 
Manual Advance On.
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2.   Play the SlideShow by clicking the Play 
button.

3.   Click the mouse or press any key on your 
keyboard (except Escape) to advance.

Printing Your SlideShow
You can print each picture in your SlideShow, one 
at a time, on its own piece of paper, or you can 
print small versions of the pictures onto one page. 
You can print as many pictures at one time as can 
fit on one piece of paper. 

To print your SlideShow:

1.   Click the Print button.

2.   Pick one of these formats:

•    Full Page prints each picture on its own 
piece of paper, one at a time. Type the 
number for the page to print in the 
Starting Picture box.
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•    Card/Booklet prints each page on one 
panel of a piece of paper folded into 
quarters. 

To make a card, print one slide onto the 
first panel and write on the other panels.

To print four pictures on a page, choose 
Card/Booklet and type 1 in the 
Starting Picture box and 4 in the 
Ending Picture box. To print the next 
four pictures, choose Print again and 
type 5 in the Starting Picture box and 8 
in the Ending Picture box, and so on.

•    Comic Book prints six pictures on each 
piece of paper. 

To print six pictures on a page, choose 
Card/Booklet and type 1 in the 
Starting Picture box and 6 in the 
Ending Picture box. To print the next six 
pictures, choose Print again and type 7 
in the Starting Picture box and 12 in 
the Ending Picture box, and so on.

•    Thumbnail prints twenty-four pictures 
on each piece of paper.
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To print twenty-four pictures on a page, 
choose Thumbnail and type 1 in the 
Starting Picture box and 24 in the 
Ending Picture box. If your slideshow is 
longer than that, choose Print again and 
type 25 in the Starting Picture box and 
50 in the Ending Picture box, and so 
on.

3.   If you picked Card/Booklet or Comic 
Book, pick one of these:

•    Portrait holds the paper the tall way, and 
prints Comic Book pictures two across 
and three down.

•    Landscape holds the paper the wide way 
and prints Comic Book pictures three 
across and two down.

4.   Type the page numbers for the starting and 
ending pictures to print. 

5.   Click OK to print the SlideShow.
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Saving Your SlideShow
SlideShows are saved in your My SlideShows 
folder (inside the My Pictures folder). 

To save your SlideShow:

1.   Click the Save button.

2.   Type a name for your SlideShow.

3.   Click Save.

Exporting Your SlideShow
You can export a copy of your SlideShow to play 
without Kid Pix, or to play on another computer 
with Kid Pix. Exported SlideShows don’t include the 
Text-to-Speech feature. For information on Text-to-
Speech, see “Reading Text Out Loud” on page 37.

To export your SlideShow:

1.   Click the File menu.

2.   Click Export.
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3.   Navigate to where you want to save your 
exported SlideShow.

4.   Type a name for the exported SlideShow.

5.   Choose an export format.

•    SlideShow to Go Creates a folder with 
everything you need to run your 
SlideShow on a different computer with 
Kid Pix.  

Copy the resulting folder to the other 
computer, then use the Open command 
on the File menu to open the SlideShow 
file in that computer’s version of Kid Pix. 
Kid Pix will find all the files it needs to 
show your slideshow.

•    QuickTime Can be played on any kind of 
computer but requires a QuickTime plug-
in to play. To download the plug-in, go to 
www.apple.com. Only timing advance 
options are supported. Transitions are not 
included.

To play the resulting file, use the QuickTime 
plug-in to open and play your exported file.

6.   Click Save.
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The Kid Pix Deluxe 3 Menus
 In this chapter, you’ll learn about:

• The File Menu

• The Edit Menu

• The Add Menu

• The Toolbox Menu

• The Controls Menu

• The Email Menu

• The Small Kids Mode Menu

• The Help Menu
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The File Menu 

New
Creates a new Kid Pix picture or SlideShow. For 
details, see “Starting a New Picture” on page 67 
and “Starting a SlideShow” on page 73.

Open
Lets you open a Kid Pix picture or SlideShow. Kid 
Pix first looks in your My Pictures or My SlideShows 
folder, but you can browse other folders on your 
computer. For details, see “Opening a Picture” on 
page 69 and “Creating and Opening SlideShows” on 
page 72.

Save As
Saves the open picture or SlideShow. For details, 
see “Saving a Picture” on page 68 and “Saving Your 
SlideShow” on page 89.
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Export
Saves your picture or SlideShow in a different for-
mat. For details, see “Exporting a Picture” on 
page 70 and “Exporting Your SlideShow” on 
page 89.

Print
Prints the open picture or SlideShow. For details, 
see “Printing Your Picture” on page 62 and “Printing 
Your SlideShow” on page 86.

Log In as New User
When you log in as a different user, Kid Pix uses the 
settings and folder locations for that user. For 
details, see “Setting Up Multiple Users” on 
page 101.

Exit
Closes Kid Pix and returns you to your computer 
desktop. You can also click the door in the middle of 
the right side of the Paint Zone to exit.
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The Edit Menu 

Undo/Redo
Undo reverses the last change you made. Redo 
reverses the last Undo. 

Cut
Removes the current selection and places it on the 
Clipboard. 

Copy
Puts a copy of the current selection on the Clip-
board. 

Paste
Pastes whatever is on the Clipboard. 
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The Add Menu 

Add Graphic
Adds a picture created in another program to your 
Kid Pix picture. For details, see “Adding Pictures 
from Other Programs” on page 56.

Add Movie
Adds a QuickTime movie to your Kid Pix picture. For 
details, see “Adding QuickTime Movies” on page 58.

Load Picture
Places a picture in the current slideholder of your 
SlideShow. For details, see “Loading Pictures” on 
page 74.

Import Background
Lets you use a picture created in another program 
as the background for your Kid Pix picture. For 
details, see “Importing Backgrounds” on page 46.
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Import Sound
Lets you use a sound on your computer as the 
attached sound for your Kid Pix picture. For details, 
see “Sounds” on page 52.

The Toolbox Menu 

Edit ABC Text
Lets you type the text to paint with a Wacky Brush. 
For details, see “ABC Text Tool” on page 32.

Check Spelling
Checks the spelling in all the text boxes in your pic-
ture. For details, see “Checking Spelling” on 
page 36.

How to Pronounce
Lets you teach Kid Pix how to say words it doesn’t 
know, like names and places. For details, see 
“Teaching Kid Pix to Pronounce” on page 39.
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Flatten Text
Makes text boxes part of the background. You can 
flatten just the selected text box or all text boxes. 
For details, see “Working with Text Boxes” on 
page 33.

Flatten Stickers and Animations
Makes stickers part of the background. You can flat-
ten just the selected sticker or all stickers. For 
details, see “Stickers” on page 48.

Change Effects
Lets you customize the settings for your SlideShow. 
For details, see “Customizing Your SlideShow” on 
page 78.

Pick Background Color
Sets the background color for your SlideShow. For 
details, see “Background Color” on page 84.
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The Controls Menu 

Turn Tool Sounds On/Off
Sets whether tools and buttons make sounds when 
you click them. For details, see “Controlling Sound” 
on page 103.

Turn Text-To-Speech On/Off
Sets whether Kid Pix reads the text in text boxes 
when you play your page. For details, see “Reading 
Text Out Loud” on page 37.

Turn Attached Sound On/Off
Sets whether Kid Pix plays the attached sound 
when you play your page. For details, see “Control-
ling Sound” on page 103.

Turn Manual Advance On/Off
Temporarily overrides the transition settings in your 
SlideShow, so you have to click the mouse to 
advance the slides. For details, see “Switching to 
Manual Advance” on page 85.
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Clean Up
Gets rid of the blank slots in your SlideShow. For 
details, see “Getting Rid of Blanks” on page 77.

Go to Slide Show/Paint Zone
Switches you from the Paint Zone to SlideShow and 
vice versa. For details, see “Going to SlideShow” on 
page 73 and “Editing Pictures” on page 75.

The Email Menu 

Set up
Lets you control whether a child can email Kid Pix 
pictures from within Kid Pix or not. For details, see 
“Emailing Your Picture” on page 63.

Send
Uploads the current Kid Pix picture to the Internet, 
where it can be viewed by a friend. For details, see 
“Emailing Your Picture” on page 63.
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The Small Kids Mode Menu 

Turn Small Kids Mode On/Off
Switches between modes. For details, see “Activat-
ing Small Kids Mode” on page 102.

The Help Menu 

Help
Gives you on-the-spot help. For details, see “Get-
ting Help” on page 6.

About Kid Pix Deluxe 3
Tells you which version of the program you have.

View User Guide
Displays this User Guide in Acrobat Reader.
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Options for Parents and Educators
In this chapter, you’ll learn about:

• Setting Up Multiple Users

• Activating Small Kids Mode

• Controlling Sound

Setting Up Multiple Users
You can set up multiple users at one time for class-
room use, or if lots of kids use the same computer.

To change settings for multiple users:

1.   At the Login screen, type KidPixAdmin 
and then click Go.

2.   Type the names of the new users and click 
Add after each one.

3.   To delete a user, select the name to remove 
and click Delete.

4.   Click Done when you’re finished.
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Activating Small Kids Mode
Kid Pix has two modes: Normal Mode and Small 
Kids Mode. In Normal Mode, all the Kid Pix tools 
and features are active. In Small Kids Mode, com-
plex features (like menu options, SlideShow, and 
printing) are hidden. This lets younger children cre-
ate freely, without confusion.

In Small Kids Mode, children can:

• Use all the art tools. 

• Add text to a picture using rubber stamps, 
instead of the keyboard. When a child clicks 
a letter in the tray, Kid Pix says the letter’s 
name out loud.

To use Small Kids Mode:

1.   On the Small Kids Mode menu, click Turn 
Small Kids Mode On.

2.   To return to Normal Mode, click Turn Small 
Kids Mode Off.
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Controlling Sound
You can turn Tool Sounds, Attached Sounds, and 
Text-to-Speech on or off for each user.

To set sound settings:

1.   Click the Controls menu.

2.   Set each of the following:

•    Turn Tool Sounds On/Off 
determines whether you hear sound 
effects when you use the tools and trays 
in Kid Pix.

•    Turn Attached Sound On/Off 
determines whether the attached sound 
plays when you play the picture.

•    Turn Text-To-Speech On/Off 
determines whether you hear text boxes 
read aloud when you play the picture.

When you turn a setting off, the command reads 
“Turn... On” and when you turn a setting on, the 
command reads “Turn...Off.”
OPTIONS FOR PARENTS AND EDUCATORS 103



K I D  P I X  D E L U X E  3
Frequently-Asked Questions
The questions and answers in this chapter include:

• Why do some things become part of the 
background, while others remain separate?

• How can I move a Kid Pix file from one com-
puter to another?

• Can I save a Kid Pix picture or SlideShow in 
another format, so other people can see it?

• How can I set up multiple users and make 
the settings different for each one?

• How do I use the Sound Art brushes?

• What’s the difference between Rubber 
Stamps and Stickers?

• What’s the difference between animations 
and animated Wacky Brushes?
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Why do some things become part of the back-
ground, while others remain separate?

In Kid Pix, a picture is like a piece of paper with a 
layer of clear plastic over it. Things you add to the 
background cover over each other, just as if you 
painted them on a piece of paper. Items like stick-
ers, animations, sounds, movies, and text boxes 
float over the background, on the plastic layer. 
They remain independent until you flatten them. 
Flattening an object merges it into the background.

You can pick up items on the plastic layer and move 
them, resize them, and (for animations or movies) 
play them.

Some actions cause things to flatten, even if you 
don’t flatten them yourself. For example, when you 
export a picture, many of the object flatten as a 
result, because the export format doesn’t know 
how to display them otherwise.
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How can I move a Kid Pix file from one com-
puter to another?

Can I save a Kid Pix picture or SlideShow in 
another format, so other people can see it?

These two questions are related.

To move the picture or SlideShow to another com-
puter that has Kid Pix on it, save the picture on a 
removable disk, or export the SlideShow as a 
“SlideShow to Go.”

To move the picture or SlideShow to another com-
puter without Kid Pix on it, export it in a format the 
other computer can play. For more information, 
see“Exporting a Picture” on page 70 and “Exporting 
Your SlideShow” on page 89.

How can I set up multiple users and make the 
settings different for each one?

Log in as KidPixAdmin to set up multiple users. 
Then, log in as each user in turn and set up Kid Pix 
for that user. For details, see “Setting Up Multiple 
Users” on page 101.
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How do I use the Sound Art brushes?

Sound art brushes paint abstract images that get 
their size, and shape from the pitch and volume of 
your computer’s sound input device. Talk or sing 
into your computer’s microphone, and the sound 
art brush will “paint” those sounds.

To choose a sound art brush, display the Painting 
tools and click the microphone in the tray. Then 
click the Hands-free or Mouse-move option in 
the tool options tray. 

If you choose Hands-free, you can make noise 
into the microphone and Kid Pix will paint. If you 
choose Mouse-move, you can drag the mouse and 
make noise at the same time to form the painting. 
For details, see “Using Painting Tools” on page 11. 
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What’s the difference between Rubber Stamps 
and Stickers?

Rubber Stamps are pictures you “stamp” onto 
your picture. They immediately flatten into the 
background. You can edit rubber stamps using the 
Pencil in the Rubber Stamp tray. For details, see 
“Using Rubber Stamps” on page 20. You can’t edit 
the Rubber Stamps once you’ve added them to 
your picture.

Stickers are pictures you add to your Kid Pix picture 
that remain independent objects. You can move 
and resize them until you flatten them. For details, 
see “Stickers” on page 48.

What’s the difference between animations 
and animated Wacky Brushes?

Animations are stickers that move, like very small 
movies. Animations play when you play your pic-
ture. Animations remain independent objects after 
you add them to your picture. You can move and 
resize them until you flatten them. For details, see 
“Animations” on page 50.
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Wacky Brushes and Spray Cans are Painting tools 
that paint with magical effects. After you paint with 
them, they animate for a short period, then flatten 
into the background bitmap. You can’t move or 
change the results of a Wacky Brush or Spray Can 
the way you can an animation. For more informa-
tion, see “Using Painting Tools” on page 11.
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Getting Technical Support
Contact our Technical Support in these ways:

• Call our Technical Support Call Center from 
8:00 AM to 8:00 PM CST at

319-247-3333.

• Email a description of your problem to

help@tlcsupport.com.

• Contact us 24 hours a day by faxing

319-395-9600.

• Write to us at

Broderbund, 1700 Progress Drive, PO Box 
100-TS, Hiawatha, IA 52233-0100 USA, 
Attn: Kid Pix
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C
Card/Booklet
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Change Effects command 97
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Check Spelling command 36, 96
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E
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Eraser button 27
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settings for 28
sizes for 28
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Exit command 93
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about 106
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for printing pictures 62
printing SlideShows as 86

fuzzy erasers 28

G
GIF pictures

adding 56
adding as backgrounds 47

Go to Paint Mode command 99
Go to SlideShow command 99
Grab tool

moving objects with 40
Grab tray

Copy tool 41
Paste tool 41

H
help

on-the-spot 6
Help menu 100
How to Pronounce command 96

I
Idea Machine 68
Import Background 

command 47, 95
Import Sound command 54, 96
italics for text 35

J
JPEG pictures

adding 56
adding as backgrounds 47
exporting as 70

K
Kid Pix

customizing 101
libraries 43
menus 91
starting on Macintosh 3
starting on Windows 2

Kid Pix Deluxe 3 User Guide 6
KidPixAdmin 101

L
Landscape orientation

for printing 88
libraries 43
library buttons 43
library trays 45

folders 45
little eraser 28
Load button 75
Load Picture command 95
Log In as New User 

command 93
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M
Marker tool 9
mega-mixer 18
menus

displaying 6
in Kid Pix 91

Microphone
in Sounds tray 55

mini-mixer 18
Mixer button 18
Mixers 18

effects 18
sizes 18

Mixers tray 18
movies

adding 60
deleting 41
moving 41
playing 59
playing frame-by-frame 59
playing in a loop 59
playing once 51
resizing 60

moving
animations 51, 58
objects with Grab tool 41
pictures in SlideShow 76
stickers 49
text boxes 33

multiple users
setting up 101

My Pictures folder 92

My SlideShow button 78
My SlideShows folder 74
My Sounds folder 52

N
naming

SlideShows 89
New button 67
New command 92
New SlideShow button 73
Normal Mode

setting up 102

O
Open command 69, 74, 92
opening

pictures 69
SlideShows 74

orientation
for printing 88

P
Paint Zone 4
Paint Zone button 75
Paintbrush

realistic 12
wacky 12

Painting Tools 11
modes 11
sizes 11

Painting Tools button 11
Paper Texture 24
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Paper Texture button 24
Paper Texture tray 24
Paste command 77, 94
pasting

objects with Grab tool 41
pictures in SlideShow 76

pattern
Fill Bucket 15

Pencil
for Rubber Stamps 22

Pencil tool 9
photographs

adding 56
Pick Background Color 

command 84, 97
PICT pictures

adding 56
adding as backgrounds 47
exporting as 70

pictures
adding 56
deleting from SlideShow 77
exporting 70
loading into SlideShows 74
moving in SlideShow 76
moving in SlideShow by 

dragging 76
moving to another 

computer 106
naming 68, 69
new 67
opening 69
pasting in SlideShow 76

playing 61
printing 62
saving 68

Play button 61
in SlideShow 85

Polygon Grab tool 42
polygons

drawing 10
Portrait orientation

for printing 88
Poster

for printing pictures 62
Print button 62

in SlideShow 86
Print command 93
printing

Full Page 62
orientation 88
pictures 62
Poster 62
range of pages in 

SlideShow 88
SlideShows as booklets 87
SlideShows as cards 87
SlideShows as comic books 87
SlideShows as thumbnails 87
SlideShows on individual 

pages 86
pronunciation

specifying for text-to-
speech 39
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Q
QTMovies folder 59
question mark button 7
QuickTime

exporting as 71
exporting SlideShows as 90

QuickTime movies
location on CD 58

R
Read Me 7
rectangles

cutting out 42
Redo command 94
Repeat Many Times

for backgrounds 47
for pictures 57

resizing
animations 51
stickers 49
text boxes 34

Restore Original
for Rubber Stamps 22

reversing actions 28
rotating

Rubber Stamps 23
Rubber Stamps

adding 20
changing 21
coloring 22
creating 21
drawing 22

editing 21
erasing 23
flipping 23
rotating 23
sizes 20

rubber stamps
and stickers 108
reading out loud 37

Rubber Stamps button 20
Rubber Stamps tray 20

S
Save As command 92
saving

pictures 68
SlideShows 89

Say It This Way command 39
scrolling

SlideShow 77
Send command 65, 99
Set up command 64, 99
setting up

multiple users 101
sounds 103

sharp erasers 28
Shrink/Stretch to Fit Canvas

for backgrounds 47
for pictures 56

slide advance options
in SlideShow 78
Key Down 80
Mouse Click 80
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Read Text Done 80
Timer 80

SlideShow
deleting blank slides 77
printing a range of pages 88
scrolling 77
silent transitions 82
slide advance options 78
visual transitions 82

SlideShow button 73
SlideShow to Go

export format 90
SlideShow tray 73
SlideShows 5, 72

background color 84
customizing 78
exporting 89
exporting as QuickTime 90
exporting for use on another 

computer 90
loading pictures 74
moving to another 

computer 106
new 73
opening 74
playing 85
printing 86
saving 89
sounds for 83
starting 73

Small Kids Mode
setting up 102

Small Kids Mode menu 100
Solid Fill bucket 15
sound art

about 107
Sound Art brush

hands-free 13
mouse-move 13

Sound button 53
Sound Recording tray 55
sounds

adding 52
importing 52
in SlideShow 78
recording 52
setting up 103

Sounds tray 53
microphone 55
Trash Can 55

spelling
checking 36

Spray Can
3D Shapes mode 14
Moving Paint mode 14

Square Grab tool 42
squares

cutting out 42
Stand-alone

exporting as 71
starting

new pictures 67
SlideShow 73
with the Idea Machine 68
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startup window 2
Sticker button 48
stickers

adding 48
and rubber stamps 108
copying 41
deleting 41, 49
edit frame 49
flattening 49
flipping left to right 49
flipping top to bottom 49
library for 44
moving 41, 49
resizing 49

Stickers tray 48

T
Technical Support 110
text 29

adding in Big Kids Mode 30
adding in Small Kids Mode 31
aligning 35
centering 35
changing in Small Kids 

Mode 35
changing size of 35
changing style 35
reading out loud 37

text boxes
copying 41
deleting 34, 41
flattening 34

formatting text in 35
moving 33, 41
moving off page 34
resizing 34

Text button 30
text style

changing 35
Text tray 30

Voice 38
Text-to-Speech

changing voice for 38
pronunciation 39

Thumbnail
printing SlideShows as 87

Toolbox menu 96
transition effects

and sounds 82
in SlideShow 80

Transition Effects arrow 81
Trash Can

in SlideShow 77
Turn Attached Sound On 

command 98, 103
Turn Manual Advance On 

command 85, 98
Turn Small Kids Mode On 

command 100, 102
Turn Text-To-Speech On 

command 37, 98, 103
Turn Tool Sounds On 

command 98, 103
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U
underline for text 35
Undo command 94
Undo Guy 28

V
View User Guide 7
View User Guide command 100
visual transition effects

in SlideShow 78

W
Wacky Brush

and animations 109
and text 32

WAV files
importing 54
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Copyright Information
Copyright ©2000, Broderbund, Inc., and its affili-
ates and licensors. Contains Macromedia Flash 
Player software by Macromedia, Inc., Copyright 
©1995-1999 Macromedia, Inc.  All rights reserved. 
The Proximity/Merriam-Webster Database Copy-
right 1994 Merriam-Webster, Inc. Copyright 
©1994. All rights reserved. Proximity Technology, 
Inc., Broderbund, and Kid Pix are registered trade-
marks and Kid Pix Deluxe is a trademark of Broder-
bund, Inc. Macromedia and Flash are trademarks of 
Macromedia, Inc. QuickTime and the QuickTime 
logo are trademarks used under license. QuickTime 
is registered in the U.S. and other countries. All 
other trademarks are the property of their respec-
tive owners.

In the interest of product improvement, information 
and specifications represented here are subject to 
change without notice.
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